# Table of Contents

SUMMARY ................................................................................................................................. 7

System requirements .................................................................................................................. 9

Installation .................................................................................................................................. 11

Launching 5nine Manager ......................................................................................................... 17
  Single instance launch ............................................................................................................. 17
  Multiple instances launch ......................................................................................................... 17

Customizing object tree .......................................................................................................... 18
  Object types ............................................................................................................................. 18
  Adding objects to the tree ........................................................................................................ 18
  Moving objects to another datacenter .................................................................................... 21
  Editing objects .......................................................................................................................... 22
  Removing objects .................................................................................................................... 22
  Refreshing object tree .............................................................................................................. 22

Dashboard ................................................................................................................................. 23
  Datacenter ............................................................................................................................... 23
  Cluster ....................................................................................................................................... 24
  Host .......................................................................................................................................... 25
  Virtual machine ..................................................................................................................... 26

Options ....................................................................................................................................... 28
  Guest console ........................................................................................................................... 28
  E-mail notifications .................................................................................................................. 29
  Optimizer & Monitor ................................................................................................................ 30
  Capacity Planning ................................................................................................................... 34
  Templates & Sysprep ................................................................................................................ 35
  Task log retention period ........................................................................................................ 38
  Reset checkboxes .................................................................................................................... 38

Hyper-V Settings ...................................................................................................................... 40
  Creating a new virtual machine ............................................................................................. 44
Creating a new virtual hard disk ................................................................. 57
Editing virtual hard disk .................................................................................. 61
Operations with virtual machines ................................................................. 67
  View settings .................................................................................................. 67
  Standard operations ....................................................................................... 69
Adding and removing VM to/from cluster ...................................................... 72
Configure VM network settings ................................................................. 67
Import VM ....................................................................................................... 74
Export VM .................................................................................................... 75
Clone VM ..................................................................................................... 76
VM Migration ................................................................................................ 77
  VM migration using Move Wizard ............................................................... 77
Live and quick VM migration .......................................................................... 81
Changing VM settings ................................................................................ 82
Converting VM to template or sysprep ......................................................... 98
Fibre channel adapter .................................................................................. 100
Operations with Hyper-V hosts ................................................................. 102
Replication ................................................................................................... 104
  Virtual machine replication settings .......................................................... 109
  Failover TCP/IP settings ........................................................................... 109
  Test failover settings ................................................................................. 110
  Replication settings .................................................................................. 111
Network configuration .............................................................................. 113
  Virtual Switches ......................................................................................... 113
  Network Connections ............................................................................... 115
  Physical Adapters ..................................................................................... 115
Optimizer ...................................................................................................... 115
  Setting up dynamic optimization .............................................................. 116
  Changing host dynamic optimization settings ........................................ 121
  Changing general dynamic optimization settings .................................. 121
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up dynamic optimization rules</td>
<td>122</td>
</tr>
<tr>
<td>Background operations</td>
<td>124</td>
</tr>
<tr>
<td>Support information</td>
<td>125</td>
</tr>
<tr>
<td>Little disk space notification</td>
<td>126</td>
</tr>
<tr>
<td>Enable Remote Management</td>
<td>127</td>
</tr>
<tr>
<td>Best Practices Analyzer</td>
<td>128</td>
</tr>
<tr>
<td>Hyper-V logs</td>
<td>129</td>
</tr>
<tr>
<td>Library</td>
<td>130</td>
</tr>
<tr>
<td>VM templates</td>
<td>130</td>
</tr>
<tr>
<td>Virtual disks</td>
<td>131</td>
</tr>
<tr>
<td>ISO images</td>
<td>132</td>
</tr>
<tr>
<td>Using file manager</td>
<td>133</td>
</tr>
<tr>
<td>Working with transfer virtual disk. Copying files between VMs or between VM and host</td>
<td>135</td>
</tr>
<tr>
<td>Integration services</td>
<td>137</td>
</tr>
<tr>
<td>Monitor</td>
<td>138</td>
</tr>
<tr>
<td>Host</td>
<td>138</td>
</tr>
<tr>
<td>Virtual machine</td>
<td>140</td>
</tr>
<tr>
<td>Capacity planning</td>
<td>142</td>
</tr>
<tr>
<td>The approach</td>
<td>142</td>
</tr>
<tr>
<td>Dashboard</td>
<td>143</td>
</tr>
<tr>
<td>System status report</td>
<td>144</td>
</tr>
<tr>
<td>System Status Report can be generated only on the host level</td>
<td>144</td>
</tr>
<tr>
<td>Cluster operations</td>
<td>147</td>
</tr>
<tr>
<td>Create cluster</td>
<td>147</td>
</tr>
<tr>
<td>Validate cluster</td>
<td>151</td>
</tr>
<tr>
<td>Cluster maintenance mode</td>
<td>152</td>
</tr>
<tr>
<td>Antivirus</td>
<td>153</td>
</tr>
<tr>
<td>Integration with other products</td>
<td>154</td>
</tr>
</tbody>
</table>
Licensing.......................................................................................................................... 158
License installation........................................................................................................... 159
License removal.................................................................................................................. 160
Product updates.................................................................................................................. 161
Product support.................................................................................................................. 162
5nine Manager log files...................................................................................................... 163
Uninstall.............................................................................................................................. 164
Resources............................................................................................................................ 165
SUMMARY

5nine Manager is a virtual infrastructure management tool, joining standard Hyper-V manager functions and virtual network management tools. 5nine Manager for provides an easy-to-use graphical interface for all editions of Hyper-V. It installs easily on the full and core versions of Windows Server 2008 R2 SP1, Windows Server 2016/2012 R2/2012 and Hyper-V Server 2016/2012/2008 R2 SP1. 5nine Manager is the only Hyper-V management tool that installs directly on a Windows Server Core or a Free Hyper-V Server.

5nine Manager has its own file manager with the ability to copy files between VMs, and between a VM and host. The ease of transfer allows easy operating on OS without GUI and file explorer. This feature is an added value compared to the standard MS Hyper-V manager, which will not allow these operations.

5nine Manager performs ALL functions of Hyper-V Management, including:

- Removing and editing virtual machines, virtual networks, and virtual disks.
- Supporting Generation 2 virtual machines creation (applies for hosts with Windows Server 2012 R2).
- Viewing resource allocation and utilization of virtual machines.
- Full virtual machine checkpoint management.
- Shared nothing live migration.
- VM Replication.

Additionally, 5nine Manager has the following features that are absent in the standard MS Hyper-V management tool:

- Own graphical user-friendly interface – file manager with built-in transfer virtual hard drive with a capacity up to 127 Gb for exploring files and network shares, even on Windows Core and Free Hyper-V.
- Dashboard providing summarized data view for managed objects.
- Quality of Service management – setting of minimum and maximum Input Output operations per second (IOPS) throttling for the virtual hard disk attached to a virtual machine (applies for hosts with Windows Server 2012 R2).
- Ability to change VM IPv4 network settings without accessing guest OS.
- System Status Report presented in the intuitive graphical form.
- Cluster support, live and quick VM migration.
- Hyper-V monitoring feature provides graphical view of performance indicators on host (with history) and VM levels.
- Optimizer feature provides dynamic load balancing between Hyper-V hosts.
- Capacity planning feature designed to track and timely alert the user about problems with the performance and capacity of virtual Hyper-V infrastructure and provide the forecast.
• E-mail notifications about various Hyper-V events.
• Template/Sysprep feature that allows converting virtual machines to templates or sysprep hard virtual disks.
• Best practice analyzer.
• Hyper-V logs viewer.
• Library to store VM templates, virtual hard disks and ISO images.
System requirements

Supported Operating Systems:

- Windows Server
  - Windows Server 2016
  - Windows Nano Server (Remotely Managed)
  - Windows Server 2016 Core
  - Windows Server 2012 R2
  - Windows Server 2012 R2 Core
  - Windows Server 2012
  - Windows Server 2012 Core
  - Windows Server 2008 R2 SP1
  - Windows Server 2008 R2 SP1 Core

- Microsoft Hyper-V Server
  - Microsoft Hyper-V Server 2016
  - Microsoft Hyper-V Server 2012 R2
  - Microsoft Hyper-V Server 2012
  - Microsoft Hyper-V Server 2008 R2 SP1
  - Windows 8.1 with Hyper-V role enabled
  - Windows 8 with Hyper-V role enabled

- Windows
  - Windows 10 with Hyper-V role enabled
  - Windows 8.x with Hyper-V role enabled

Software Prerequisites:

- .NET Framework 4.5 or higher.
- MS SQL Server (in the case SQL server is used instead of local SQLite database to store monitoring data).

Service accounts – permissions:

- WMI access. Full access to the namespace Hyper-V WMI provider (V2) (ROOT\virtualization\v2) is required.

- SQL database or file access (read/write) – only if external SQL server and Windows authentication are used.

- Storage folder full access (VM configuration files, ISO, VHD, templates).

- Allow to control Hyper-V. In most cases this requirement is covered since local administrator’s privileges requirement is already met.

- Host Service user should have local administrator’s privileges. This requirement is usually met when the user is a member of local administrators group on the Hyper-V host or
Administrators group in Active directory in the case of domain environment.

- If a host or a cluster is managed remotely, there should also be an account with similar permissions specified in authentication settings for the managed object (or in settings for parent datacenter object). Please refer to the ‘Customizing object tree’ section below.

Other requirements:

Managed Hyper-V hosts and remote management machine/host (if applicable) must be trusted for Kerberos Constrained Delegation (trust to any service is preferable option; trust to “cifs” and Microsoft Virtual System Migration services are minimal requirements) and must be specified in the access list for the storage folder with full access (VM configuration files, ISO, VHD, templates).
Installation

To install 5nine Manager, run the 59Manager.exe application from the downloaded 5nine Manager archive:

The 5nine Manager Setup wizard will appear:
Click Next. The 5nine Software End User License Agreement will appear. Accept it and click Next:

![End-User License Agreement](image)

Select the license .txt file and click Next:

![Custom Setup](image)
Select the folder for 5nine Manager:

Set the following program behavior options (select or deselect depending on your preferences):

- Automatically run 5nine Manager when system starts;
- Launch application after installation;
- Create shortcut in program menu;
- Create shortcut on desktop.
Select the data source to store the 5nine_monitor database:

- Local SQLite database – this is a locally stored small sqlite file – non-configurable database. This option does not require having any pre-installed SQL instance in your environment and is the right choice for low-demanding monitoring data – not more than 2 Hyper-V hosts with totally less than 20 virtual machines and keeping monitoring history not longer than 7 days.

- MS SQL – this option requires having pre-installed MS SQL instance – either MSSQL server or SQLEXPRESS, and is the proper choice for larger environments and high demands of keeping monitoring history.

**Note.** These options are not configurable after installation of 5nine Manager. Please, do the right choice at once. Otherwise, you will need to re-install the application to set another type of data source.
In the case you have chosen “MS SQL” data source option at the previous step, the following settings will be requested at the next step:

Select database server and set authentication method:

- **Windows Authentication** – can be set if the user that has been set at the previous step is granted the necessary permissions on the selected SQL Server;

- **SQL authentication** – use specific SQL Server account (sa) that is set during SQL Server setup and enter its password.
Confirm installation:

When installation is complete, click Finish:

The installation is complete.
Launching 5nine Manager

Single instance launch

To start single instance of 5nine Manager use its shortcuts on the computer(s) where it is installed. The common single instance will be launched:

Multiple instances launch

Launching multiple instances of 5nine Manager allows splitting up the program into independent parts (instances); each of those will operate its own list of Hyper-V hosts and will have its own database. Maximum recommended number of hosts in 5nine Manager single console is 15-20 depending on the number of VMs per host. In case of greater amount of Hyper-V hosts, it is recommended to use several instances and distribute Hyper-V hosts between them.

To launch each new instance, open command prompt and change the current folder to: \Program Files\5nine\5nine Manager\ and then use the following command:

5nine.Manager.exe /instance:<instance name>

where <instance name> is any name you should choose to identify the instance.

The console will be launched the same way as for single instance, but it will have its own list of Hyper-V hosts (empty at the first time) and the instance name will be displayed in the header.

The data for each instance will be kept at the following location on the server running 5nine Manager:

C:\ProgramData\5nine\5nine Manager for Hyper-V\<instance name>
Customizing object tree

After installation, all VMs based on the local host will be added to the object tree under the 5nine Manager datacenter, created by default.

Object types

The following objects are presented from the 5nine Manager point of view:

- DataCenter. This object needs to be added before any other objects. DataCenter is a formal aggregating entity that is used for the purpose of joining the other objects as its subsidiaries.

- Cluster. The cluster object represents multiple servers (nodes) joined in a cluster. It shows all VMs hosted on the cluster nodes. Locally created VMs on the nodes are not shown here.

- Host. Host object represents a single server and shows all VMs on it.

Adding objects to the tree

To add a new object to 5nine Manager tree, use the main panel menu commands (or Edit → Add Object menu commands):
Use **Add DataCenter** menu command to add the new data center to the object tree:

![Add DataCenter dialog box](image)

Enter the following parameters:

- The name of new data center;
- Authentication type – either use default credentials or specify them manually.

Staying on the DataCenter entity, use the **Add Cluster** and/or **Add Host** menu commands to add the new cluster or host to the object tree accordingly:

![Add Cluster dialog box](image)

Enter the parameters for new cluster and host:

- Type the address. You may use host name, FQDN or IP address. You can use auto search for convenience – click the **Discovery** button and then click one of available discovery options:
  - **Active Directory** – to search for available hosts or clusters using AD discovery;
  - **IP Band** – to search for available hosts or clusters using IP discovery. Set IP discovery parameters in the following dialog box:
Select either IP range or Subnet mask and IP address as search options, specify necessary values and click the Start button to begin the search.

When the search is done, mark hosts or clusters, which you need to add to the object tree and click OK:

- Authentication type – either use default credentials or specify them manually.
The new added objects will appear in the tree on the left:

Moving objects to another datacenter

A host or a cluster can be moved from one datacenter to another. To move a host or a cluster right click on it and choose Move. Then select data center and press Ok:
The selected object will be moved to the new datacenter:

To edit any object in the 5nine Manager tree, select the necessary object and click the **Edit** button on the main panel menu or use Edit → Edit Object menu command. Then enter the new parameters for selected object in the following dialog and click **OK**:

**Removing objects**

To remove any object from the 5nine Manager tree, select the necessary object and click the **Delete** button on the main panel menu or use Edit → Remove Object menu command. Then click **OK** on the system warning message.

**Attention!** Removing the grouping entity (DataCenter) automatically removes all its subsidiaries.

**Refreshing object tree**

To refresh the object tree or change its view use the View menu commands:

- View → Tree View to get the spanning tree object view;
- View → List View to get the list object view;
- View → Refresh (or button on the main panel menu) to refresh the object tree.
Dashboard

Dashboard shows summarized data for each object type – datacenter, cluster and host in the Summary tab of 5nine Manager main window.

Datacenter

Datacenter summarized data view displays overall health for its objects – host health, VMs health and cluster health. Each object type is shown as a circle diagram with the total number of objects divided by those that are healthy and those that have errors:

Green color shows healthy objects (19 objects in total on the picture).

Red color shows objects with errors (4 objects in total on the picture).

Orange color shows objects with warnings (5 objects in total on the picture).
Latest alarms are shown in the lower part of the **Summary** tab. To filter alarms, use the corresponding buttons:

- to filter by object type:
  - turn cluster alarms displaying on/off;
  - turn host alarms displaying on/off;
  - turn VM alarms displaying on/off.

- to filter by alarm type:
  - turn alerts (errors) displaying on/off;
  - turn warnings displaying on/off;
  - turn info displaying on/off.

**Cluster**

Cluster summarized data view displays the following info:

- General info: cluster name, role/node count, current owner (host server), networks and subnets.
- Cluster shared volumes info with details.
- Health diagrams for the cluster nodes and virtual machines.
- Latest cluster and VM alarms.

**Host**

![Image of the Host Summary page](image)

Host summarized data view displays the following host info:

- General host info: host FQDN, up time, OS version, CPUs, total and available RAM.
- Detailed info: BIOS version, domain, domain role, hardware manufacturer and model, system type.
- Host disks info.
- Health diagrams for the virtual machines on the host.
- Latest host and VM alarms.
- Additional data: presence of the hypervisor on the host, host IP addresses, whether it is a virtual machine or a physical server, whether it is a part of domain.
You can connect to the host via RDP directly from the dashboard. Click the **RDP Connect** button and select the endpoint to establish RDP session to the host:

![RDP Connect](image)

**Virtual machine**

Virtual machine summarized data view displays the following info:

- **General VM info**: VM ID, current parent host, VM state, guest OS version, VM generation, integrated services version, DNS name, IP addresses, processor load, memory load and the list of active tasks with the current progress percentage for each task.

- **Storage info** (data and configuration): name, type, path and capacity (free of total size) of the storage, total size of the virtual disk and VM configuration files. The **Refresh Storage Usage** button lets you refresh these data.

- **Networks info**: name and type of each virtual network connection.
• Latest VM alarms.

The following commands are additionally available for virtual machine on the **Summary** tab: turn off, shutdown, save, pause/resume, reset, create checkpoint, rename, edit VM settings, and connect via guest console. All these commands are available among the other ones from VM context menus and the main panel menu on the **Hyper-V Manager** tab. Please refer to the ‘Operations with virtual machines’ – ‘Standard operations’ section below for detailed information about VM operations.
Options

The following options are available to customize 5nine Manager (Options command in View menu):

- Guest Console.
- E-mail notifications.
- Optimizer and Monitor settings.
- Templates and Sysprep settings.
- Task log settings.
- Reset confirmation checkboxes.

Guest console

Ability to choose client for guest connection:

- FreeRDP VM connection – have to be used if 5nine Manager is installed directly on a Hyper-V server without GUI.
- Microsoft VM connection – the best choice for any other options.

Smart sizing option is available for both Free RDP-based and Microsoft RDP-based clients:
E-mail notifications

5nine Manager can send e-mail notification about different Hyper-V events to administrator’s e-mail. To start receiving notifications fill **Enable e-mail notifications** checkbox, set e-mail server access parameters and define sender and recipients e-mail addresses.

**Note.** Only explicit SSL authentication is supported.

Then select what action 5nine Manager should inform administrator.
Note. Antivirus notification option applies to program version with antivirus module – 5nine Manager with Antivirus.

Optimizer & Monitor

Set parameters for Optimizer and Monitor features (please refer to the ‘Optimizer’ and ‘Monitor’ sections below for details):

In the General tab set performance counters:

- Performance counters probing interval. It determines the frequency of Optimizer and Monitor data updating. Default value is 5 seconds.

- Optimizer automatic migration frequency for virtual machines to balance load. Default value is 120 seconds.

- Monitor alarm generation interval. An alarm will be generated if the average value of the performance counter exceeds its threshold within specified time period. Default value is 120 seconds.

- Alarm generation frequency. This parameter defines the limit for the frequency period to generate an alarm for the same VM/host performance counter. An alarm will not be generated more often than the specified value. Default is 60 seconds.

- Mark the Disable host monitoring option to switch off monitoring for any Hyper-V host. You may also exclude specific host(s) from monitoring instead using monitor exclusions as described further.
In the **Monitor Thresholds** tab set thresholds for Monitor notifications:

- CPU, Memory, Disk Time in percent and Network utilization in kbps for Hyper-V hosts.
- CPU utilization in percent, Memory utilization in MB, disk and network utilization in kbps for virtual machines.

The thresholds are set for warning and critical values. All values are set to “0” by default, which means the thresholds are disabled.

The option “Generate alarm when trend exceeds the threshold” is enabled by default. This option will evoke alarm if the graph intersects the trend green line just like when it exceeds the threshold. Please refer to the ‘Monitor’ section below for details.
In the **Monitor exclusions** tab you may specify hosts that will be excluded from monitoring:

- Select host(s) from the hosts list on the left. Use Ctrl and Shift keys to multiple selection.
- Move selected hosts to the right field to exclusions list by clicking the right double arrow button.
- To remove the host(s) from exclusions do the opposite action and left double arrow button to move them back to monitored hosts list.
In the **Retention** tab you can set the retention period in days for monitor historical data. The default value is 30 days:

![Retention Tab](image)

In the **Event Settings** tab you can review and edit various events for monitoring:

![Event Settings Tab](image)
The upper field displays the events sources, which are pre-defined and are not editable. The lower field displays events list for each source. It already contains main events for each source, but you may edit the list of these events. To view and/or edit the events, select the source in the upper field. The lower field will display the current list of events.

To add the new event, click the **Add** button and type the new event ID and description:

![Add event dialog box](image)

**Note.** The events are pre-defined for each source. You should know the exact ID and the meaning of the event to add it to the list. For example, failover clustering events can be found in this article: [https://technet.microsoft.com/en-us/library/cc753362(v=ws.10).aspx](https://technet.microsoft.com/en-us/library/cc753362(v=ws.10).aspx).

To remove the event, select it in the lower field and click the **Remove** button.

### Capacity Planning

Set general parameters for capacity planning feature (please refer to the ‘Capacity planning’ section below for details):

![Capacity planning options](image)

- Estimate period in days
- Forecast period in days
- Period to refresh data in minutes
Templates & Sysprep

Set parameters for library items – templates, virtual hard disks and ISO files in the **General** tab:

- Specify VM templates, VHDs and ISO folder paths. Use UNC format (i.e. `\Server\Folder`).

**Prerequisites.**

It is important to set proper permissions for the locations, servers and users so that templates work as expected:

- Both servers, i.e. Hyper-V host and machine running 5nine Manager management console (further referred to as “managing machine”), and user, under which Hyper-V host is managed, should be trusted for Kerberos Constrained delegation. Trust to any service is preferable option, “cifs” is minimal required trusted service:
- Shared folders should have properly configured permissions for both users and computers: user under which Hyper-V host is managed, host itself and managing machine should be added to share’s security list with full access:

  ![Image](image_url)

- Enable *Skip rearm* option to omit running Windows Software Licensing Rearm program in the templates with Windows OS family.
Set parameters for sysprep agent and copying files in the **Advanced** tab:

- Remote copy files and start agent methods. They both are set to WMI by default and it is recommended option. In the case WMI does not work in the environment, try Power Shell (PS) option.
- Forcibly try Kerberos constrained delegation. This option determines whether Kerberos should be forcefully tried when WMI method is used. It may get the following states:
  - Kerberos constrained delegation check is disabled when the checkbox is empty. The operation will happen with default scenario.
  - Kerberos constrained delegation parameters will be applied if possible. This is default option ( ).
  - Kerberos constrained delegation will be tried forcefully ( ).
- Kerberos constrained delegation settings:
  - Kerberos service prefix “cifs” is default value that will be used in WMI command parameters:
    ```powershell
    $scope.Options.Authority = "kerberos:cifs/$accountName.$domain"
    ``
    If the prefix is empty then there will be no prefix:
    ```powershell
    $scope.Options.Authority = "kerberos:$accountName.$domain"
    ``
  - Kerberos timeout is set to 180 sec by default, it depends on system performance. The lower performance, the greater the value should be to prevent operation failure due to time out.
Task log retention period

Task log shows the list of all tasks, including earlier finished, in the system. User can set retention period in days for the tasks stored. If a task is older than this period of time it is removed from the list.

Reset checkboxes

5nine Manager stores information about user’s choice when performing different operations. For example, if Please do not ask me again checkbox was filled 5nine Manager will not show this dialog anymore until user presses Reset button.
**Reset Checkboxes** option is intended for cancelling of all stored checkbox states.
Hyper-V Settings

To change Hyper-V Settings for a host, select a host in the tree and press the (Hyper-V Settings):

Use the Stop Service button to stop all VMs on a selected host. You can start them again by pushing the Start Service button.

You can change folders for information storage:

- Default folder to store virtual disk files.
- Default folder to store virtual machine configuration files.

And set the following options:

- Allow virtual machines to span physical NUMA nodes.
- Allow enhanced session mode.

The Apply settings to other hosts button allows to apply settings to other hosts.

The following options can be chosen:

- Copy VMMS settings.
- Copy Migration settings.
- Copy Replication settings.

To apply setting, select hosts and press **Apply**.

Use Migration tab to switch over to Migration settings:

You can set the following options:

- Enable incoming and outgoing live migrations.
- Specify the number of simultaneous live migrations.
- Use any available network
  or
- Use the specified IP addresses. Press **Add** button to add IP Address:
Specify the number of storage migrations.

And performance configuration options:

- TCP/IP
- Compression
- SMP

On the Replication tab set replication settings if the current Hyper-V host is supposed to be used as a replica server. Please, refer to the ‘Replication’ section below for detailed information regarding replication and its prerequisites.

- **Enable this computer as a Replica server.** Mark this option to set the current Hyper-V host as a replica server.

- Set authentication parameters:
  - **Use Kerberos (HTTP).** This authentication option uses Kerberos authentication protocol via HTTP port 80 (default).
➢ Use certificate-based Authentication (HTTPS). This authentication method uses pre-installed certificate and works via HTTPS port 443 (default). Click the Select Certificate... button to choose pre-installed certificate on the current Hyper-V host:

- Set authorization and storage parameters:

➢ Allow replication from any authenticated server. Any Hyper-V host that is set as a replica server in the environment will be allowed to send Replica files. Specify the default location by typing or browsing to the folder to store Replica files.

➢ Allow replication from the specified servers. Only specified Hyper-V hosts will be allowed to send Replica files. Click Add... to add the authorized server to the list:

- Specify the primary server. Use FQDN or IP address.
- Specify the default location for Replica files on the current Hyper-V host.
- Specify the trust group which Hyper-V hosts must belong to receive primary virtual machine.
Creating a new virtual machine

To create a new virtual machine (VM), first you need to select the host on which the VM will be seated. Select either of the two ways to create a new VM:

1. Select the host within the cluster sub-tree so that the new VM is created as a clustered VM; Or
2. Select the host as a separate entity in the 5nine Manager tree so that the new VM is created as a local VM.

Click the (Create New VM) button on the main panel menu or Edit → Create New VM menu command. The Create Virtual Machine wizard will be opened:

Select one of options to create virtual machine:

- **Create new virtual machine.** This option will allow you to create the new VM.
- **Create from existing virtual machine.** This option will allow you to select the existing VM to create the new one from:
• **Create from virtual machine template.** This option will allow you to select template to create virtual machine from. Template should be previously created from one of existing VMs (please refer to the ‘Operations with virtual machines – Converting VM to template or sysprep’ section below).

![Select VM Template](image)

Click next. Further steps are basically the same for all options listed above.

![Create Virtual Machine](image)

• Enter the VM name (“New Virtual Machine” is the default name for the option *Create new virtual machine*).

• Select the location to store the new VM configuration file. The default location is `%ProgramData%\Microsoft\Windows\Hyper-V` for a locally created VM, this parameter can be changed in Hyper-V settings of the hosts. To change the default location, first mark the “Store the virtual machine in a different location” option, then either type or browse for the new location.

• Mark the “Clustered VM” option to make the new virtual machine highly available. Note that VM configuration should be stored in CSV rather than on local disk. The default location will be changed accordingly when this option is enabled.

• Enter notes (optional).

Click **Next**.
Note. If you click **Finish** at this or in any of the following steps, the new VM will be created with the default parameters that you haven’t altered during creation process.

Specify generation of the new VM:

- “Generation 1” – to create the VM with the older virtual hardware, as in earlier versions of Hyper-V;
- “Generation 2” – to create the VM with support of newer features, such as Secure Boot, SCSI boot and PXE boot.

Note. The option “Generation 2” is available only on the hosts running Windows Server 2012 R2. For earlier version, it is disabled and only “Generation 1” option is available.

Click **Next**.
Assign CPU parameters for the new VM:

- Set the number of virtual processors, as required, to allow maximum percentage of physical CPU utilization. The default value covers 100% of host CPU and depends on the number of processors available on the host.

- Set resource controls to balance resources between virtual machines:
  - Virtual machine reserve in percent (0 is default value).
  - Virtual machine limit in percent (100 is default value).
  - Relative weight. This parameter determines virtual machine priority amongst the other VMs to allocate resources.

- Mark the “Migrate to a physical computer with a different processor version” option to limit the processor features that a virtual machine can use. This improves the virtual machine’s compatibility with different processor versions.

- Mark the “Run an older operating system, such as Windows NT” option in the case an older OS version is used on VM to improve the virtual machine’s compatibility with older OS versions.

- Set NUMA topology parameters in the case non-uniform memory access is enabled on a virtual machine (dynamic memory allocation should be disabled to enable NUMA):
  - Maximum number of processors (maximum value is 64, default value is 1).
  - Maximum NUMA nodes allowed on a socket (maximum value is 64, default value is 1).

Click Next.
Assign memory for the new VM:

- Enter the necessary amount of memory in MB in the **Startup RAM** field. The default value is 512 MB. You can use arrows to the right of the field to alter this figure within the min/max range, from 8 to 14116 MB. Consider the OS memory requirements that will be used on the VM.
  
  **Note.** Please enter memory in increments 2MB

- Enter max memory blocks per NUMA node in MB, to determine NUMA node boundaries by dividing the amount of physical RAM by the number of logical processors (cores).

- Set the memory allocation mode. Memory can be allocated either statically or dynamically in accordance with needs and host physical resources availability. Mark the **Use Dynamic Memory for this virtual machine** box to enable the dynamic memory allocation for the VM. If the box is not marked (default setting), the static memory allocation applies to VM.

- If dynamic memory allocation is enabled, minimum and maximum RAM should be determined to set boundaries for the virtual machine, default limits are preset depending on the environment.

- Set the memory buffer to reserve the memory. Default value is 20%.

- Move the slider between “Low” and “High” to set the memory weight of the virtual machine between the other virtual machines on the host to prioritize physical memory assignment.
The lower the slider position is set the less the priority. In certain cases it may prevent VM from starting if host memory resource is low.

Click **Next**.

**Attention!** Please configure network prior to VM creation.

Configure a network adapter for the new VM. You can select one of the following values:

- Not connected. There will be no virtual network adapter attached to the new VM. The VM will remain disconnected from the network until the network adapter is added at a later time.

- Any adapter presents on the list. It depends on what kind of virtual network switches have been previously configured on the host (please refer to the “Network configuration” section). The new VM will be using this connection.

- Select MAC address obtaining option – **Dynamic** to set the virtual NIC physical address dynamically, or **Static** – and enter the MAC address manually (the default value is present).

- Tick **Enable MAC address spoofing** to enable masking of the virtual NIC MAC address if necessary.

- Tick **Enable virtual LAN identification** and then enter the VLAN identifier (number) if the VM is supposed to use VLAN for all network communications through this virtual network adapter.
Virtual NIC advanced settings

The following advanced virtual network features can be configured on the Advanced Settings tab:

- Enable NIC teaming.
- Enable DHCP Guard.
- Enable Router Guard.
- Protected network. The VM will be moved to another cluster node if the network connection problem occurs on the current node (in the clustered environments).
- Port mirroring: Destination or Source. Will send copied packets to another VM that is configured for monitoring (if there is such available).
- Bandwidth management options: minimum and maximum allowed levels of network bandwidth utilization for virtual network adapter (“0” is set for unrestricted utilization and it is default value for both thresholds).
- Hardware acceleration options:
  - Enable VMQ (Virtual Machine Queuing).
  - Enable SR-IOV (Single Root Input/Output Virtualization).
- IPsec tasks offloading. Maximum number of security associations (SA) to be offloaded from the processing by guest OS means to the physical NIC to support it. Range from 1 to 4096, the default value is 512.
With options “Create from existing virtual machine” and “Create from virtual machine template” the Configure Networking view will be a little different:

By default, the “Add this network adapter” option is marked and corresponding connection is pre-selected depending on VM template’s or existing VM’s settings. If you unmark this option, new VM will be created without any vNIC.

Click the Settings button to check and, if necessary, change virtual network adapter parameters, as described above.

Click OK to close the dialog window and then click Next in the Create Virtual Machine wizard.
Connect a virtual hard disk for the new VM. Options are as follows:

- **Create a new virtual hard disk.** The new empty virtual disk in VHDX format will be created at the default location (%\Users\Public\Documents\Hyper-V\Virtual Hard Disks\New Virtual Machine.vhdx). A disk type can be chosen: either Dynamically Expanding or Fixed Size. You can change the default size (127 GB) up to 64 TB maximum value for the new virtual hard disk. You also can select a different location as the file name by clicking the **Browse** button.

- **Use an existing virtual hard disk.** This option allows you to select the existing virtual hard disk of either VHD or VHDX format, located in %\Users\Public\Documents\Hyper-V\Virtual Hard Disks folder by default. To select the existing virtual disk, click the **Browse** button and locate the VHD or VHDX file, either at the default path or any other.

- **Copy virtual disk from library.** This portion allows you to select the existing virtual hard disk from library. To select virtual hard disk from library, click the **Browse** button to the right from the **Original Path** filed and select the virtual hard disk from the dialog box below.

- **Attach a virtual hard disk later.** The new VM will be created without virtual hard disk. You will be able to attach it later.

Virtual hard disks should be previously created or copied to the location that is set as a virtual disk library storage. Please refer to the “Options” – “Templates & Sysprep” and “Library” – “Virtual disks” sections for detailed information.
With options “Create from existing virtual machine” and “Create from virtual machine template” the **Connect Virtual Hard Disk** view will be a little different:

By default, the “Add this hard disk” option is marked, virtual disk size is set as originating virtual disk size and the default path is selected. You may alter these parameters if necessary. If you unmark this option, new VM will be created without any virtual hard disk.

**Advanced features**

If the VM is created on the host with OS Windows Server 2012 R2, the advanced features are available when attaching a virtual hard disk. These features consist of managing the Quality of Service by setting the minimum and maximum input/output operations per second (IOPS) for the virtual hard disk attached to the VM and ability to enable virtual hard disk sharing. To set these parameters, click the **Advanced Features** button on the wizard.

**Note.** The **Advanced Features** button appears on the wizard only for the hosts running Windows Server 2012 R2, since the QoS management feature applies to these hosts only.
The **Advanced Features** dialog will appear:

![Advanced Features dialog](image)

**QoS management**

Tick the **Enable Quality of Service management** box to enable this feature and set minimum and maximum IOPS in 8 KB increments. Click **OK**. Click **Next** on the wizard.

**Virtual hard disk sharing**

To enable virtual hard disk sharing, tick the **Enable virtual hard disk sharing** box to let the VHD be used by multiple VMs simultaneously.
Click **Next** to select OS installation options.

**Attention!** These settings are available only for the option “Create new virtual machine”.

- **Install an operating system later.** When choosing this option, there will be no OS installed on the VM during the creation process, but you will be able to install it later. To install OS on a newly created VM, connect to it via 5nine Guest Console and select installation *.iso* file from **Media** menu.

- Install an operating system from a bootable CD/DVD-ROM. Select the media type from which to install the OS:
  - **Physical CD/DVD drive** – Use this option to install the OS from physical CD or DVD drive available on the host;
  - **Image file (.iso)** – Use this option to install the OS from disk image file. You will have to locate the file:
    - Click the **Browse** button and choose the path to the *.iso* file.
    - Click the **From Library** button and select the *.iso* image from the dialog box below:
ISO images should be previously copied to the location that is set as ISO library storage. Please refer to the “Options” – “Templates & Sysprep” and “Library” – “ISO images” sections for detailed information.

- **Install an operation system from a network-based installation server** – Use this option to install the OS from a network. This function is available for Generation 2 VMs only and when the network adapter is connected.

Click **Next**.

Review parameters for the new VM. To start the VM as soon as it is created fill in **Start VM after creation** checkbox. Click **Finish** to complete the VM creation process.
Creating a new virtual hard disk

To create a new virtual hard disk, first select the host on which the disk is created in 5nine Manager object tree. The host can be either a separate entity or a part of the cluster. In the last case, the new virtual hard disk will be created on the cluster shared volume and could be accessed by its nodes.

Click the (Create Virtual Disk) button on the main panel menu or Edit → Create Virtual Disk menu command. The Create Virtual Disk wizard will be opened:

Set the format for the new virtual hard disk:

- **VHDX** (default setting) – the new virtual disk format that supports size up to 64 TB and is able to protect itself from being corrupted due to power failures. Requires OS Windows 8 or later.

- **VHD** – the older virtual disk format that supports size up to 2040 GB and can be used in older OS Windows versions.

**Note.** If you click Finish at this or any of the following steps, the new virtual disk will be created with the default parameters that were not altered during the creation process.
Set the type for the new virtual disk:

- **Dynamic Expanding** (default setting) – the virtual disk will be dynamically expanded or reduced as the data is added or deleted. This type saves the physical hard drive space, but reduces disk performance;

- **Fixed Size** – the virtual disk size will remain unchanged as it is set regardless of the data being written onto it. This type keeps the performance level, but does not save physical space on the hard drive.

- **Differencing** – the virtual disk will be created as a child VHD(X) of an existing virtual disk. Any further changes applied to a child do not affect the parent virtual disk. Child and parent disk formats must match.

Click Next.

Specify the name and location for the virtual hard disk file. The default location and name are %\Users\Public\Documents\Hyper-V\Virtual Hard Disks\NewDisk.vhdx for locally created virtual hard disks. You can change the default name and path by entering the desired values in the Disk Path.
field manually, or by clicking the **Browse** button and then selecting the location and entering the desired file name in the following dialog.

In the case you are creating a disk of a differencing type you will also have to specify the parent virtual disk to create a child:

Specify the name and location for the parent virtual hard disk file. Use the **Browse** button for convenience. Click Next.

Specify parameters for the new VHD(X):

- Set the size of the virtual disk in GB. The default size is 128 GB. You can use the arrows to the right of the field to alter this figure.
- Set the block size for the VHD(X), 0 sets autosize.
- Set the logical and physical sector size for the VHD(X): 512 bytes or 4096 bytes (4 Kb). 512 is set as default.
Click Next.

Review the summary information for the new virtual hard disk and click **Finish** to complete the creation process. The corresponding message will appear in the case of successful operation.
Editing virtual hard disk

To edit an existing virtual hard disk, first select the host on which the disk is located in 5nine Manager object tree. The host can be either a separate entity or a part of the cluster. It will only affect the default location of the existing virtual disk, but you will be able to select either one during the editing process. Click the \( \text{(Edit Virtual Disk)} \) button on the main panel menu or \textbf{Edit} \( \rightarrow \) \textbf{Edit Virtual Disk} menu command. The \textbf{Edit Virtual Disk} wizard will be opened:

Specify the location of the existing virtual hard disk file. The default location is \( \%\text{\textbackslash Users}\%\text{\textbackslash Public}\%\text{\textbackslash Documents}\%\text{\textbackslash Hyper-V}\%\text{\textbackslash Virtual Hard Disks} \) for virtual hard disks located on the local host. Click the \textbf{Browse} button and then select the existing virtual hard disk.

The full path of the selected virtual hard disk will be shown in the field. Click \textbf{Next}:
Choose from the following actions, which will depend on what you want to do with the virtual hard disk:

- **Compact.** This option will reduce the size of the virtual hard disk, but the storage capacity will remain the same. Click **Next**.

- **Convert.** This option will copy the existing virtual hard disk to a new virtual hard disk. At the next step, you will be able to choose a different type and format than the original virtual hard disk.

- **Expand.** This option will expand the capacity of the existing virtual hard disk.

- **Shrink.** This option will reduce the storage capacity of the virtual hard disk. This applies only to the virtual hard disks with fixed size.

Click **Next**. The following steps will vary depending on the action selected.
Compact action:

Review the summary for compact action and click **Finish** to complete the editing process of the virtual hard disk.

Convert action:

Reconfigure the parameters to convert the existing virtual hard disk:

- **Disk format.** Select the format VHDX or VHD for the converted disk. Omit this parameter if you want to leave it the same as the original virtual hard disk.

- **Disk type.** Select the type for the converted disk. Omit this parameter if you want to leave it the same as the original virtual hard disk.
- **Disk Path.** Specify the name and location for the virtual hard disk file. The default location and name are %C:|Users|Public|Documents|Hyper-V|Virtual Hard Disks|NewDisk - Copy.vhdx for local virtual hard disks.

You can change the default name and path by entering the desired values in the Disk Path field manually or click the Browse button and then select the location and enter the desired file name.

Click Save and then click Next.

![Edit Virtual Disk](image)

Review the summary for convert action and click Finish to complete the editing process of the virtual hard disk.

*Expand action:*

![Edit Virtual Disk](image)
Set the new size of the virtual disk in GB. You can use the arrows to the right of the field to set this figure. The maximum size depends on the virtual hard disk format – 64 TB for VHDX and 2040 GB for VHD. Click **Next**.

Review the summary for the expand action and click **Finish** to complete the editing process of the virtual hard disk.

**Shrink** action:

This option will reduce the storage capacity of the virtual hard disk. This only applies to fixed size virtual hard disks.
Review the summary for shrink action and click **Finish** to complete the editing process of the virtual hard disk.
Operations with virtual machines

All the operations with the existing VMs are done on the Hyper-V Manager tab:

<table>
<thead>
<tr>
<th>Name</th>
<th>State</th>
<th>CPU Usage</th>
<th>Assigned Memory</th>
<th>Memory Demand</th>
<th>Memory Status</th>
<th>Online Status</th>
<th>Status</th>
<th>Application Health</th>
<th>Host</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dev-C01</td>
<td>Running</td>
<td>0%</td>
<td>2.5 GB</td>
<td>2.6 GB</td>
<td>OK</td>
<td>OK</td>
<td>NotAvailable</td>
<td>NODE2.dev.local</td>
<td></td>
</tr>
<tr>
<td>Dev-C01</td>
<td>Running</td>
<td>0%</td>
<td>2.5 GB</td>
<td>2.6 GB</td>
<td>OK</td>
<td>OK</td>
<td>NotAvailable</td>
<td>NODE2.dev.local</td>
<td></td>
</tr>
<tr>
<td>Dev-C02</td>
<td>Running</td>
<td>0%</td>
<td>2.5 GB</td>
<td>2.6 GB</td>
<td>OK</td>
<td>OK</td>
<td>NotAvailable</td>
<td>NODE2.dev.local</td>
<td></td>
</tr>
</tbody>
</table>

View settings

The following options are available to configure the view of the Hyper-V Manager tab and displaying virtual machines:

- Choose columns to display. Right click on the headers’ area of the VMs list and then click Column Chooser:

Drag-n-drop columns between the displayed area and this dialog box to customize the displayed columns set. Right-click on the column will also add it to the displayed area. The Remove this
column context menu command will move the unwanted column from the displayed area back to the dialog box.

- Search VMs. 5nine Manager can search and filter VMs list by VM name:

```
<table>
<thead>
<tr>
<th>Name</th>
<th>State</th>
<th>CPU Usage</th>
<th>Assigned Memory</th>
<th>Memory Demand</th>
<th>Memory Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>VM2012R2-empl</td>
<td>Off</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Enter the wanted symbols in the row and the VMs’ list will be filtered accordingly. You also can use the Find button while 5nine Manager still looks up for you automatically. Click the Clear button to drop the search/filter criteria.

- Auto Filter. This feature allows selecting/filtering VMs by any search parameter: name, state, CPU usage etc – by any column. To enable auto filter, right click on the columns’ headers area and select the Show Auto Filter Row command. The upper row will appear above VMs list:

```
<table>
<thead>
<tr>
<th>Name</th>
<th>State</th>
<th>CPU Usage</th>
<th>Assigned Memory</th>
<th>Memory Demand</th>
<th>Memory Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>VM2012R2-empl</td>
<td>Off</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Type or select from the list (where applicable) the wanted value – the VMs list will be immediately filtered in accordance with these criteria. You may hide auto filter with the Hide Auto Filter Row command and still be able to apply it by clicking on the sign on the tiny funnel sign on the right of each column: 

Then select the values from the list. Custom auto filter – (custom) value allows using of logical expressions:

```
[Custom AutoFilter]

To edit filter, click the Edit Filter button on the right, then select/enter the necessary parameters – all items in the Filter Editor dialog box are clickable:
To enable/disable filter use the checkbox located under the VMs list. Filter criteria history is also available. Click x to remove the filter:

- Best content fit for columns. When you are done with customizing displayed columns set, use either the Best Fit context menu command for each column or the Best Fit (all columns) context menu command to best fit the content for all displayed columns as better as possible.

- Group VMs by column. This feature helps you to group VMs by different criteria for your convenience.

**Standard operations**

5nine Manager supports standard operations with virtual machines (corresponding right-click commands are also available for these actions). Group operations with virtual machines are also supported. For this purpose, you need to select several VMs and run appropriate command.

- Start. To start the VM, click the Start button on the Hyper-V Manager tab menu panel.

- Turn off. To turn the VM off, click the Turn Off button on the Hyper-V Manager tab menu panel.

- Shut down. To shut the VM down, click the Shutdown button on the Hyper-V Manager tab menu panel.

- Save. To save the VM, click the Save button on the Hyper-V Manager tab menu panel.

- Pause/Resume. To pause or resume the VM, click the Pause (Resume) button on the Hyper-V Manager tab menu panel.

- Reset. To reset the VM, click the Reset button on the Hyper-V Manager tab menu panel.

- Checkpoints: Create, Delete, Apply, Revert, Rename.
➢ To create a Checkpoint for the VM, click the Checkpoint button on the Hyper-V Manager tab menu panel. Checkpoint will appear in the lower window in approximately one minute:

Further clicks on the Checkpoint button will create subsidiaries to the previous Checkpoint:

➢ To revert the VM to its last taken Checkpoint, click the Revert button on the Hyper-V Manager tab menu panel. Confirm the operation.

➢ To apply any Checkpoint from the tree to the VM, select the necessary Checkpoint and click the Apply button in the lower window panel or by using an appropriate context menu command. Confirm the operation.

➢ To delete the selected Checkpoint, click the Delete button in the lower window panel or Delete with sub-tree button, which will delete the whole sub-tree (the same context menu commands are also available).

➢ To rename the selected Checkpoint, click the Rename button in the lower window panel (or by using the context menu) and then enter the new Checkpoint name in the dialog:

• Rename. To rename the selected VM click the Rename button on the Hyper-V Manager tab menu panel and then enter the new VM name in the dialog:

• Delete. To delete the VM, you have to turn it off first. Then the Delete button becomes available on the Hyper-V Manager tab menu panel. Click it and confirm the operation:
You can either delete virtual hard disks attached to this VM or leave them untouched and clear or leave the VM configuration folder.

- Connect to a VM via Guest Console or RDP, when it is possible. To connect to the VM using 5nine Guest Console, double-click on the VM or click the Connect button on the Hyper-V Manager tab menu panel (VM context menu command is also available at your choice).

The same operations are available in the Guest Console menu – Start, Turn Off, Shut Down, Save, Create Checkpoint, Pause/Resume, Revert:

Connect via RDP option allows you to choose from the DNS name, IP v4 and IP v6 addresses, to perform the Remote Desktop Connection.
Adding and removing VM to/from cluster

To remove a clustered VM from cluster, select the cluster in the 5nine Manager object tree, and then select the VM that you need to remove from cluster and right click on it. Select the Remove From Cluster option.

If you want to add a non-clustered VM to a cluster, select the Add to Cluster option. Make sure you have moved the VM configuration to the CSV prior to adding it to a cluster (please refer to the “VM Migration” – “VM migration using Move Wizard” subsection below).

Configure VM network settings

5nine Manager lets you change IPv4 network settings of a VM without accessing guest OS. This feature is available from VM context menu – Set IP address command. If VM has more than one Network adapter, you have to choose the necessary one prior to configuring the IP properties:
Configure the IPv4 properties:

Click OK. The new IP v4 configuration will be applied to the VM.
Import VM

To import VM press the ▼ (Import VM) button on main panel menu or Edit → Import VM menu command. The Import Virtual Machine window will be opened:

- Specify the directory that contains VM data. Default location (%ProgramData%\Microsoft\Windows\Hyper-V\Exported Virtual Machines\).

- Specify the location of VM’s system definition file (.xml or *.exp). Default location (%ProgramData%\Microsoft\Windows\Hyper-V\Exported Virtual Machines\).

- Specify configuration file for the imported VM. Default location (%ProgramData%\Microsoft\Windows\Hyper-V\Imported VMs\).

- Specify storage directory for imported VM. Default location (%Users%\Public\Documents\Hyper-V\Virtual Hard Disks\Imported VHDs\).

- With enabled option Specify custom name for imported VM, you can type the new name for the imported VM into VM Name field.
Export VM

To export your VM, right click on the VM and select the Export command. The Export Virtual Machine wizard will appear:

Edit the path where you would like to save exported VM files if necessary (the default path is `<current VM location>\Exported Virtual Machines\<VM name>`). Use the Browse... button to select the target location. Click Next.

Review the summary and click Finish to perform the export operation.
Clone VM

To clone your VM, right click on the VM and select the **Clone** command. The **Clone Virtual Machine** wizard will appear:

- Edit the path to save temporary exported VM files if necessary (the default path is `<current VM location>\Exported Virtual Machines`). Use the **Browse...** button to select the target location.

- Enter the name for VM clone. The default name is `<VM name> - clone`.

- Set the number of clones. A maximum of 100 clones can be created. The default number is 1.

- Edit the path for the clones’ configuration files if necessary (the default path is `<current VM location>\Imported VMs`). Use the **Browse...** button to select the target location.

- Edit the path for the clones’ storage if necessary (the default path is `<current VM location>\Imported VHDs`). Use the **Browse...** button to select the target location.

Click **Next** to review the details and summary of the VM cloning operation and then click **Finish** to perform the operation.
VM Migration

VM migration using Move Wizard

This operation allows moving VM with/without its storage or a VM storage only to another Hyper-V host. This operation is available in both clustered and non-clustered environments. The Hyper-V hosts must be trusted with Kerberos Constrained Delegation (KCD) properly set up to make this
operation possible. To open **Move Wizard** you must select a VM, then press the button on the **Hyper-V Manager** tab menu panel, or right click on **VM** and select **Move Wizard**.

You can Move the virtual machine or Move the virtual machine’s storage here.

Once you make your selection, press the **Next** button.

In the **Specify Destination** tab select the destination computer to move VM to and click the **Next** button.

---

In the **Choose Move Options** tab you can choose one of several options:

- Move the virtual machine’s data to a single location (this option allows you to specify one location for all of the virtual machine’s items):

When you press the **Next** button, you must choose a folder for Destination location.
• Move the virtual machine’s data by selecting where to move the items. This option allows you to select the location of each item to be moved.

• Move only the virtual machine’s virtual hard disks. This option allows you to specify locations to move the virtual machine’s virtual hard disks.

When you press the **Next** button, you must choose **Items to Move**:

In the **Specify New Locations** tab, you must choose new locations for the items:
Live and quick VM migration

These operations apply to clustered VMs. To move the VM between nodes that joined into a cluster, first select the cluster in the 5nine Manager object tree, and then select the VM that you need to move to another node and click the Move button on the Hyper-V Manager tab menu panel.

- Select either “Best possible node” so that the system will choose it automatically or select the exact node you would like the VM to be moved to.

- Select migration type:
  - **Quick Migration.** With this option a virtual machine will be migrated to another node as quickly as possible, but it will be switched to the saved state during the operation. That means access to this virtual machine will be temporarily lost until it returns to the running state on the new node. This operation is applicable to virtual machines in any state – active (running), paused, saved or off.

     - **Live Migration.** With this option a virtual machine will be migrated without switching to the saved state and losing the access. This operation is applicable to virtual machines that are in active (running) state only.

- Click OK to start migration.
Changing VM settings

To change VM settings, click the Settings button on the Hyper-V Manager tab menu panel. The Settings wizard will be opened (most of the settings can be altered only when the VM is in the “Off” or “Saved” state):

On the “Add Hardware” branch, select the type of device you want to add. Click the SCSI controller button so that you can attach a virtual hard disk, Network Adapter, and/or Fibre Channel Adapter. Click the Add button.

You will be redirected to the new SCSI controller or network adapter.

Configuring a SCSI controller:
Select the “Hard drive”. Click the Add button to attach virtual hard drive.

You are able to select the controller through which the new virtual hard drive will be connected to the VM; the newly added controller is set by default. If you change this value, the virtual hard disk will be immediately moved to the new controller. Select the location from 0 to 63 (“0” or “next free” if there are other HDs connected to a controller is set by default; “in use” means that this location is taken).
To add a virtual hard disk to the VM, you can either use the existing disk (and then edit it if necessary), or create a new one.

To create the new virtual hard disk, click the **Create** button to call out the **Create Virtual Disk** wizard (please refer to the “Creating a new virtual hard disk” section).

To select the existing virtual hard disk, click the **Browse** button and locate the vhd/vhdx file in the file system.

To edit virtual hard disk, click the **Edit** button to call out the **Edit Virtual Disk** wizard. Editing virtual hard disk process is described in the ‘Editing virtual hard disk’ section. Review the summary information for the edited virtual hard disk and click **Finish** to complete the editing process.

To inspect the virtual hard disk, click the **Inspect** button to get the disk information:

![Virtual Hard Disk Properties](image)

**Advanced features**

If the VM is created on the host with OS Windows Server 2012 R2, the advanced features are available when attaching a virtual hard disk. These features consist of managing the Quality of Service by setting the minimum and maximum input/output operations per second (IOPS) for the virtual hard disk attached to the VM and ability to enable virtual hard disk sharing. To set these parameters, click the **Advanced Features** button on the wizard.

**Note.** The **Advanced Features** button appears on the wizard only for the hosts running Windows Server 2012 R2, since the QoS management feature applies to these hosts only.
The **Advanced Features** dialog will appear:

- Tick the **Enable Quality of Service management** box to enable this feature and set minimum and maximum IOPS in 8 KB increments. Click **OK**. Click **Next** on the wizard.

- To enable virtual hard disk sharing, tick the **Enable virtual hard disk sharing** box to let the VHD be used by multiple VMs simultaneously.

To remove (disconnect) a virtual hard disk from the VM, click the **Remove** button.

Select the “Physical hard disk” option to attach a physical hard disk to the virtual machine. The list of available physical disks will appear in the drop-down box:

Configuring a virtual network adapter:
Select the necessary virtual switch to connect the VM to from the list (please refer to the “Network configuration” section to find out how the Hyper-V virtual switch is created).

Select MAC address obtaining option – Dynamic to set the virtual NIC physical address dynamically, or Static – and enter the MAC address manually (the default value is present).

Tick Enable MAC address spoofing to enable masking of the virtual NIC MAC address if necessary.

Tick Enable virtual LAN identification and then enter the VLAN identifier (number) if the VM is supposed to use VLAN for all network communications through this virtual network adapter.
Virtual NIC advanced settings

The following advanced virtual network features can be configured on the Advanced Settings tab:

- Enable NIC teaming.
- Enable DHCP Guard.
- Enable Router Guard.
- Protected network. The VM will be moved to another cluster node if the network connection problem occurs on the current node (in the clustered environments).
- Port mirroring: Destination or Source. Will send copied packets to another VM that is configured for monitoring (if there is such available).
- Bandwidth management options: minimum and maximum allowed levels of network bandwidth utilization for virtual network adapter ("0" is set for unrestricted utilization and it is default value for both thresholds).
- Hardware acceleration options:
  - Enable VMQ (Virtual Machine Queuing).
  - Enable SR-IOV (Single Root Input/Output Virtualization).
- IPsec tasks offloading. Maximum number of security associations (SA) to be offloaded from the processing by guest OS means to the physical NIC to support it. Range from 1 to 4096, the default value is 512.

To remove the virtual network adapter from the VM, click the **Remove** button.
Configuring a legacy network adapter. A legacy network adapter works without installing a virtual machine driver. The legacy network adapter emulates a physical network adapter, multiport DEC 21140 10/100TX 100 MB. A legacy network adapter also supports network-based installations because it includes the ability to boot to the Pre-Execution Environment (PXE boot). However, the legacy network adapter is not supported in the 64-bit edition of Windows Server 2003. This operation is applicable for G1 VMs only.

To add Legacy Network Adapter you need to come into the VM settings, choose Legacy Network Adapter in the list and press Add button.

Now you can specify the configuration of the legacy network adapter:

- Choose virtual switch
- Choose Dynamic or Static MAC address
- Enable MAC address spoofing
- Enable virtual LAN identification
On the **Advanced Settings** tab some of virtual NIC additional features are also available for legacy virtual NIC:

- Enable NIC teaming.
- Enable DHCP Guard.
- Enable Router Guard.
- Protected network. The VM will be moved to another cluster node if the network connection problem occurs on the current node (in the clustered environments).

- Port mirroring: Destination or Source. Will send copied packets to another VM that is configured for monitoring (if there is such available).

Configuring Fibre Channel Adapter:

**Attention!** Create fibre channel adapter on your Hyper-V host prior to configuring it on virtual machines. Please refer to the “Fibre channel adapter” section below.

Click the **Add** button to attach the Fibre channel adapter SAN for your VM.
Now you can choose Virtual SAN for your VM:

On the “BIOS” branch, set the BIOS parameters for the G1 VM:

- Tick the **Num Lock** box to turn the Num Lock on in the VM basic input output system;
- Set the order in which boot devices will be checked to start the OS. Select the device and click the **Move Up** or **Move Down** button to move the device up or down the list accordingly.

On the “Firmware” branch, that appears for the generation 2 VMs instead, set the firmware parameters for the generation 2 VM:

Secure Boot option is available for generation 2 VMs, tick the **Enable Secure Boot** box to enable this option.
On the “Memory” branch:

Set the virtual memory parameters:

- startup RAM;
- maximum memory blocks per NUMA node in MB;
- enable or disable dynamic memory allocation and set min/max levels for dynamic memory;
- memory buffer share in percent and memory weight on the host.
On the “Processor” branch, set the virtual processor parameters: the number of virtual processors used for the VM and host physical resources control parameters (reserve, limit and relative weight):

You can tick “Migrate to a physical computer with a different processor version” and “Run an older operating system, such as Windows NT”.

In NUMA Topology section you can set the values for maximum number of processors (maximum 64) and maximum NUMA nodes allowed on a socket (maximum 64).
On the “IDE Controller” branch (for generation 1 VMs), you also can add either virtual hard drive or DVD drive:

**Note.** For generation 2 VMs do the same on “SCSI Controller”.

Select the DVD Drive to add the new DVD drive to the VM and click the **Add** button.
Configure the DVD drive:

You are able to select the controller through which the DVD drive will be connected to the VM; the newly added controller is set by default. If you change this value, the DVD drive will be immediately moved to the new controller. Select the location from 0 to 63 (“0” or “next free” if there are other HDs connected to a controller is set by default; “in use” indicates that this location is taken).

Select the media type from which the DVD will be connected:

- **None** – no media will be used;

- **Image file** – select the `.iso` file to use as an image for DVD drive. You will have to locate the file by clicking the **Browse** button and choosing the path to the `.iso` file;

- **Physical CD/DVD drive** – to use the physical CD or DVD drive if it is available on the host;

To remove the virtual DVD drive from the VM, click the **Remove** button.
On the “Management” branch, set the following parameters for the virtual machine:

On the **General** tab:

- Edit the VM name in the **Name** block if necessary;
- Select/change checkpoint files location if necessary (either type in or browse for);
- Select/change smart paging files location if necessary (either type in or browse for);
- Add notes if necessary.
On the **Advanced** tab:

- **Integration services.** Select the necessary integration services options to be applied to the VM as shown.

- **Automatic startup/shutdown actions:**
  - Automatic Start Action, delay in seconds;
  - Automatic Stop Action.

The **Refresh** button will update the entire information for the VM. If there were any unsaved changes, the corresponding warning will appear before refresh is done.

At the end, click **Apply**, then click **OK** to exit the wizard.

### Converting VM to template or sysprep

**Attention!** Converting an existing VM to a template or sysprep applies Microsoft System Preparation Tool to the guest OS of virtual machine. Sysprep removes unique information from current guest Windows installation (IP configuration, domain membership etc.) to enable reusing of virtual hard disk as a template for new virtual machines. Therefore, this operation shall not be applied to the virtual machines, which currently enrolled into production and cannot allow such converting that ruins current settings. 5nine Manager will warn you about this each time you start these operations.

Before starting both operations, make sure the paths for virtual hard disks and templates are set. Please refer to the ‘Options – Templates & Sysprep’ section above for details.

- To convert virtual machine to sysprep virtual hard disk only, select the target VM and click **SysPrep and Templates – SysPrep Only** context menu command. Then confirm to the
system warning if you are absolutely sure the selected VM guest Windows installation can be reset.

- To convert virtual machine to a full template, select the target VM and click **SysPrep and Templates – Convert to Template** context menu command. Then confirm to the system warning if you are absolutely sure the selected VM guest Windows installation can be reset. Enter the name and description for the template and click OK:
Fibre channel adapter

5nine Manager supports Fibre channel adapter. To open the Virtual SAN Manager menu press the \(\text{(Virtual SAN Manager)}\) button on the main panel menu:

To create a New Fibre Channel SAN, press the \textbf{Create} button.

Here you can change name of the Fibre channel adapter, and remove virtual SAN.
Select ‘World Wide Names’ to alter the World Wide Port Name (WWPN) addresses range and World Wide Node Name (WWNN) address of the virtual Fibre Channel port:

After setting up fibre channel adapter on the host, you will be able to attach it to virtual machines in VM settings. Please refer to the “Changing VM settings” section for detailed information.
Operations with Hyper-V hosts

Apart from common operations with the tree objects as described above (refer to the ‘Customizing object tree’ section above) the following ones are additionally available for Hyper-V hosts from their context menu:

- Connect via RDP. You can access a Hyper-V host using standard Remote Desktop Connection just like it’s done with virtual machine with ability to select the endpoint DNS name, FQDN, IPv4 or IPv6 addresses:
• Shutdown a Hyper-V host. As this is a very critical action, you will be warned before the shutdown command is sent.

• Reboot a Hyper-V host. As this is a very critical action, you will be warned before the reboot command is sent.

• Show virtual disks. Right click on the Hyper-V host and select Show Virtual Disks... You will be able to see all virtual disks located on the selected Hyper-V host, get the details for each disk and edit it if necessary like described in the ‘Editing virtual hard disk’ section.
Replication

Hyper-V Replica allows virtual machines running at a primary site to be efficiently replicated to secondary location (Replica site) across a WAN link. Primary and Replica server must be Microsoft Hyper-V 2012 as a minimum.

When replication is underway, changes in the primary virtual machines are transmitted over the network periodically to the Replica virtual machines. The exact frequency varies depending on how long a replication cycle takes to finish (depending in turn on the network throughput, among other things), but generally, replication data is sent to the Replica server every 5 minutes in Windows Server 2012. In Windows Server 2012 R2, you can configure the replication frequency, so that the changes are sent every 30 seconds, every 5 minutes, or every 15 minutes.

You can also access recovery points up to 24 hours old (previously, recovery points up to 15 hours old were available).

If the primary server should fail unexpectedly, perhaps as a result of a major hardware failure or a natural disaster, you can bring up the Replica virtual machines to take over the workload—this is “unplanned failover.” In unplanned failover, there is the possibility of data loss, since there was no opportunity to copy over changes that might not have been replicated yet.

Prerequisites

To take advantage of the Hyper-V Replica, which is included as part of the Hyper-V server role, the following pre-requisites must be met:

- Hardware that supports the Hyper-V Role on Windows Server 2012;
- Sufficient storage on both the Primary and Replica servers to host the files used by virtualized workloads;
- Network connectivity between the locations hosting the Primary and Replica servers;
- Properly configured firewall rules to permit replication between the Primary and Replica sites;
- An X.509v3 certificate to support Mutual Authentication with certificates (if desired or needed)

To turn on replication, you must right click on chosen VM and to choose the **Enable Replication** function.

In the opened window you can choose the destination host as a replication server:
When host is chosen press the **OK** button.

Here you can choose Kerberos or Certificate based authentication, Enable Compression, recovery points and VSS snapshot frequency number.

You can start replication immediately or start it later at a predefined time.

To finish press the **Enable Replication** button.

Information on Replication can be found in the **Replication** tab:
To view Replication Health right click on VM and choose Replication – View Replication Health...

![Replication Statistics for 'VMWin2012-1'](image)

Unplanned Failover is an operation initiated on the replica VM when the primary VM is not available (ruined).

To initiate unplanned failover right click on VM and choose Replication – Failover...

Select recovery point and press Fail Over:

![Initiate Failover for 'VMWin2012-1'](image)

Failover will start. To cancel it, use the Replication – Cancel Failover context menu command.
To initiate test failover, select the replica VM and use the Replication – Test Failover... context menu command. Then select the recovery point to create the virtual machine to test failover:

Test failover will start at recovery connection point and the temporary test VM will be created as <VM-name> – Test:

To stop test failover use the Replication – Stop Test Failover context menu command. The temporary test virtual machine will be turned off and removed automatically.

To initiate planned failover, select the target VM on the primary Hyper-V host and use the Replication – Planned Failover... context menu command:

Note. Shut down the virtual machine at the primary Hyper-V host prior to starting planned failover operation.

Set the planned failover options:

- **Reverse the replication direction after failover.** Enable this option if you wish to switch primary and replica Hyper-V hosts.
- **Start the Replica virtual machine after failover.** Enable this option to start the replica VM after failover.

Click Fail Over. If the upper option is enabled you will see the Reverse Replication dialog box to set parameters for reverse replication. There is a separate operation for that as well (see the description below).

To initiate reverse replication use the Replication – Reverse Replication... context menu command.
Set the parameters in the same manner as described above for direct replication. With reverse replication the primary and replica servers will be switched.

To cancel failover use the Replication – Cancel Failover context menu command.

To remove recovery points use the Replication – Remove Recovery Points… context menu command. Confirm the operation.

To pause/resume replication use Pause Replication/Resume Replication commands in the same context menu accordingly. To remove replication, use the Remove Replication command.
Virtual machine replication settings

When replication is enabled on a virtual machine, the Failover TCP/IP and Test Failover tabs will appear at ‘Network Adapter’ branch in VM settings window. And the new ‘Replication’ branch will appear in the end of the settings tree. The subsections below describe these settings.

Failover TCP/IP settings

On the Failover TCP/IP tab configure IPv4/IPv6 TCP/IP settings that will be used on temporary test VM at test failover operation, as necessary:

Replica virtual machine inherits IP configuration from the original virtual machine and gets it as default settings on the recovery Hyper-V host. These settings help you to configure network configuration as you need to be set on temporary test virtual machine when the test failover operation occurs to avoid IP address conflicts in your network.
Test failover settings

Configure vNIC settings for temporary test virtual machine that will appear during test failover operation:

Select the virtual switch on the current Hyper-V host to connect temporary test VM to.
Replication settings

Replication settings are available for primary virtual machine only. Configure replication settings at the ‘Replication’ branch:

- **Replica server.** Generally, the replica server is selected at the initial step when the replication is enabled on a virtual machine. In the case you have several replica servers in your environment that meets replication requirements, you can change the target replica server. You should enter the new replica server using FQDN.

- **Specify authentication.** As when initially setting up replication on the virtual machine, there are two authentication options: Kerberos protocol based authentication method or certificate based authentication method. Default port is 80.

- **Replication frequency.** On the Hyper-V hosts with OS MS Windows Server 2012R2 you can set the frequency that the changes are sent: every 30 seconds, every 5 minutes, or every 15 minutes. The other parameters are available for both Windows Server 2012 R2 and Windows Server 2012 OS versions:
  - Whether to store only latest recovery point
  - Or a several additional recovery points. In this case specify how many (the default number is 15) and VSS snapshot creation frequency in hours (the default is 0 – to save system resources);

- **Enable compression.** Enable compression when sending changes to replica Hyper-V host.

- **Resynchronization.** Set the changes resynchronization options for primary and replica virtual machines:
➢ ‘Manual’. No auto resynchronization will occur.

➢ ‘Automatic’. The changes will be resynchronized automatically by the system at any time.

➢ ‘Automatic during the following hours’. The changes will be resynchronized automatically by the system during specified period (From/To).
Network configuration

Attention! Please configure virtual network prior to VM creation.

To configure virtual network switches, use the Network Manager tab. This tab is active when a host is selected in the object tree:

Virtual Switches

To create a new virtual switch, use the Create dropdown menu to select desired type in the Virtual Switches pane:

- **External.** In this type of virtual network connection, one of the physical NICs installed on the host is used to connect the VMs to the network. Enter the network name (the default value is “New External Virtual Network”) and select the network adapter to use for this connection in the following dialog. Tick the Enable SR-IOV box if necessary and if your environment supports Single Root Input/Output Virtualization technology. Click the Create button:

![Create New External Virtual Network dialog](image)

- **Internal.** In this type of virtual network connection, neither of the physical NICs of the host is supposed to be used for VMs that will be using this connection. VLAN can be set for this connection so that you are able to create multiple VLANs within your internal virtual
network (a separate connection should be configured for each VLAN accordingly). Enter the network name in the following dialog and click the **Create** button:

- **Private.** In this type of virtual network connection, neither of the physical NICs of the host is supposed to be used for VMs that will be using this connection, nor the VLANs could be set for it. Enter the network name in the following dialog and click the **Create** button:

Upon completing the operations described above, you will see the new network connections on the **Virtual Network Manager** tab and will be able to alter them in any way, including: changing name, type, select the new NIC and change VLAN. Click the **Apply** button to save the changes.

Virtual Switch extensions can be turned on/off in the Network Extensions window.

Press the **Extensions** button to change extensions settings:

**Note.** Remember that VMs belong to different VLANs and will not be able to communicate with each other without using a layer 3 device, such as a router, to establish inter-vlan routing. Contact your network administrator for the assistance if any problems occur at this point.
Network Connections

Hyper-V Converged Fabric fulfills network configuration best practice with the creation of virtual network interface cards (vNICs) that have bandwidth QoS settings. This alleviates the need for additional physical networking hardware beyond actual bandwidth requirements.

To create a new virtual network connection, use the Create dropdown menu to select desired type in the Network Connections pane:

- **Name**: Provide a descriptive name for the network connection
- **Switch**: Associate the connection with an existing switch
- **Bandwidth Minimum Weight**: Specifies the minimum bandwidth, in terms of relative weight, for the virtual network connection. The weight describes how much bandwidth the virtual network adapter intends to have in relative to other virtual network adapters connected to the same virtual switch. The range of the value is 0 and 100. Specify zero to disable the feature.
- **Bandwidth Maximum**: Specifies the maximum bandwidth, in bits per second, for the virtual network connection. The specified value is rounded to the nearest multiple of eight. Specify zero to disable the feature.
- The Delete menu item will remove the selected network connection

Physical Adapters

The physical adapters pane show as list of the physical adapters with their name, description and status.

Optimizer

5nine Manager provides functionality called Optimizer that performs dynamic load balancing between Hyper-V hosts in accordance with user-defined settings. There are load thresholds that are set for each Hyper-V host and once they are reached virtual machines will automatically start to migrate to another Hyper-V host that is less loaded and/or has more free physical resources available to host virtual machines. The rules can be also set to additionally manage VM migrations when dynamic load balancing occurs.
Setting up dynamic optimization

To set up dynamic optimization, go to the **Optimizer** tab:

First of all you have to select and add hosts into one of specific optimization groups:

- Click the **Add** button. The dynamic optimization setup wizard will open:

![Select Host Group](image)
• Leave the upper field as it is set by default (<New>) if you are adding the first host or setting up the new group. If you are adding the host into the existing optimization group, select this group from the list and then click **Next** omitting other actions on this screen as they are already set and will be grayed.

• Choose and enter the name for the new group.

The other actions depend on the type of the optimization group you choose:

Cluster group

This option applies only to cluster environments and only nodes of a single cluster can be added into it. When you set up the Cluster group, select the cluster from the list on the right. Click Next.

• Select the host to add to the dynamic optimization group. Only those hosts that are not added in the group yet will be available in the selection list.

• Set the thresholds:
  - CPU Time (90 % default);
  - Available Memory (90% default);
  - Total Disk Time (100% default)

• When any of these values is exceeded and less loaded host is available the VM(s) migration will be initiated by Optimizer. Click Next.
On this screen check virtual machines that you agree to be moved when dynamic optimization occurs. Unchecked virtual machines will not be migrated by Optimizer. Click Next.

Check settings. You will be able to alter all parameters except Group Name, Group Type and Cluster at a later moment. Click Finish.
Shared storage group

- This group aggregates Hyper-V hosts with virtual machines residing on a single shared storage:

Enter the name for the group and click Next.

- On this screen specify all the parameters just like when creating Cluster group. The only difference is that the storage must be also specified. Enter the storage path into the Storage path field by typing it or using the Browse... button to select the path. Click Next.

Other steps repeat those described for Cluster group above.
Mixed group

This option allows you to aggregate any type of hosts with VMs residing on different storages. Depending on the storages used for virtual machines configuration migrations may be time-consuming.

Set up parameters just like described above for Shared storage group.

To add additional hosts to the dynamic optimization group repeat the steps described above when adding a new host to a new group with selecting the specific group you want the host to be added to on the first screen of the wizard.

To remove a host from the group select the host in this group and click the **Delete** button:

Or click the **Edit Groups** button and remove the host from the list:

Select the host and click the **Remove Host** button.

Click Apply.
Changing host dynamic optimization settings

To alter dynamic optimization parameters of the monitored host, select it and click the **Edit** button:

<table>
<thead>
<tr>
<th>Host</th>
<th>CPU</th>
<th>Memory</th>
<th>Disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Group (cluster)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEMO-NODE1</td>
<td>50.04</td>
<td>83.57</td>
<td>7.38</td>
</tr>
<tr>
<td>DEMO-NODE2</td>
<td>29.01</td>
<td>27.00</td>
<td>0.14</td>
</tr>
</tbody>
</table>

Change the dynamic optimization parameters where necessary/applicable:

Click **Accept** to apply the new parameters.

Changing general dynamic optimization settings

To change general dynamic optimization settings click the **Settings** button on the Optimizer menu panel:
Set the following parameters:

- **Automatic migration frequency for virtual machines to balance load.** This parameter sets the VM migrations period for dynamic load balancing. In highly loaded environments it is set to a lower value whereas in less loaded to a greater. Default value is 600 seconds.

- **Performance counter probing interval.** This parameter sets the interval at which the host performance data are measured. Set in direct ratio with the previous parameter. Default value is 20 seconds.

Click Accept to apply the new values. The performance graphical view is displayed for each host in the lower part of the Optimizer tab:

**Setting up dynamic optimization rules**

The following rules can be set to help you additionally tune up dynamic optimization feature:

- Simultaneous migration – determines which virtual machines are migrated simultaneously at dynamic load balancing.
• Store on different hosts – determines which virtual machines must reside on different hosts at dynamic load balancing.

To set up dynamic optimization rules click the Edit Rules button on the Optimizer menu panel:

Add  Edit  Delete  Edit Groups  Edit Rules  Settings

In the **Groups** field select the group to set rules for:

Click the **Add** button to add the new rule:

• Select the type of the rule: Simultaneous Migration or Store on Different Hosts.

• Check virtual machines that the rule must apply to.

Click **Add**. Then click **Accept** in the **Edit Rules** window.

To remove the rule select the rule in the **Rules** field and click **Remove**. Then click **Accept**.
Background operations

5nine Manager allows putting time-consuming operations such as VM migration using Move Wizard, VM creation; cloning/exporting VM etc. to background. That way you can continue working with 5nine Manager while the operation that you put to background is being completed. When the appropriate operation is started, the To Background button will appear in the operation dialog or a wizard that you are currently working with – just press it and the operation will be put to background and the dialog box or a wizard will be closed:

To see how the unfinished tasks go, double click right upon the info that is always displayed in the right-lower corner status bar of the 5nine Manager main window:

0 task(s) running (total 10) (Click to show/hide) ...

The task log will appear in the lower part of main window:

Here you can see the list of all tasks, including earlier finished, with the detailed information for each operation. Unfinished tasks can be interrupted – press the Stop button to interrupt the operation before it’s completed.
Support information

5nine Manager can collect the information needed by 5nine Technical support to troubleshoot possible issues. Select **Support information** in **Help** menu, to open **Gathering information from hosts** window.

Press **Save as** to save the resulting archive. Then send it to techsupport@5nine.com.
Little disk space notification

If there is not enough space (<10% free) on a server disk or in cluster storage, 5nine Manager shows notification in status bar in the left-lower corner:

Warning! Little disk space left. Click to view message

You can press on the notice for more information:
Enable Remote Management

To get some information from remote hosts or to run commands on remote hosts specific permissions should be set. 5nine Manager can run the predefined set of PowerShell scripts on remote hosts to set necessary permissions.

To set permissions use the Enable Remote Management command from context menu on a host.

Select necessary permissions and press the Run button.
Best Practices Analyzer

The Best Practices Analyzer (BPA) becomes available when a host is selected in the object tree. To start you need PowerShell modules “ServerManager” and "BestPractices" available on a host.

You can use Best Practices Analyzer to scan a server role, and help identify configurations that do not comply with the best practices of Microsoft for this role.

If you want to update the list press Refresh button.

If you want to perform a scan, choose from the list object and press Scan button.
Hyper-V logs

5nine Manager can retrieve information from system event log and show it. To trace logs, use the Hyper-V Logs tab. This tab is active when a host is selected in the object tree:

You may use filter to retrieve the data you need and clear logs:

- Select the item in the drop-down list on the left.
- Select the available log type for selected item (“Admin”, “Operational” etc.). The events will appear in the other fields with details.

To apply filter:

- Click the Severity button in the top menu and choose which events to display (“Critical”, “Error”, “Warning”, “Information”). All types are enabled by default.
- Click the time interval button in the top menu and set the dates From/To to define the period for which events should be displayed (a period of one week back from current date is set by default):

- Click the Refresh button in the top menu to apply the filter.
- To clear all events from the currently selected log, click the Clear Log button in the top menu.
Library

Library feature provides special storage for VM templates, virtual hard disks and ISO images. This storage is read by 5nine Manager and makes operations with virtual machines such as creating a new VM and changing VM settings easier as you are able, at your choice, to select pre-created components from the specifically organized library rather than creating the new ones or searching them in an ordinary location on the host or a network. Library is managed in the Library tab of the main window:

- **Virtual Disks**: Create, Edit, Delete, Inspect, Refresh
- **VM Templates**: Name, Rename, Edit, Delete, Refresh
- **Library**

All library items – VM templates, virtual hard disks and ISO images are stored in the designated location(s), which paths are specified in the 5nine Manager options. Please refer to the “Options” – “Templates & Sysprep” section above for detailed information.

VM templates

In the upper VM Templates field you can view and manage virtual machine templates. VM templates are created from existing virtual machines (please, refer to the section “Operations with virtual machines” – “Converting VM to template or sysprep”). You cannot create a new VM template directly in the library, but you can view, edit and remove the previously created VM templates:

- Click the Refresh button to refresh the list of VM templates.
- To edit the template, select it in the list and then click the Edit button. You will see the same settings window as for virtual machine:
Not all operations are available in settings for VM template, i.e. it is not possible to add new hardware. The other settings are edited in the same way as it’s done with VM (please refer to the section “Operations with virtual machines” – “Changing VM settings”).

- To remove VM template select it in the list, then click the **Delete** button and confirm the operation.

**Virtual disks**

In the middle **Virtual Disks** field you can view and manage virtual hard disks:

- Click the **Refresh** button to refresh the list of virtual hard disks.
- To inspect a virtual disk, select it in the list and then click the **Inspect** button. You will get the summary for the selected virtual disk:
To create a new virtual disk, click the **Create** button. Then proceed in the way as described in the “Creating a new virtual hard disk” section.

**Note.** You may also copy the existing virtual disks to the designated location as described in the “Options” – “Templates & Sysprep” section above.

- To edit a virtual hard disk, select it in the list and then click the **Edit** button. Then proceed in the way as described in the “Editing virtual hard disk” section.

- To remove a virtual hard disk, select it in the list, then click the **Delete** button and confirm the operation.

**ISO images**

In the bottom **ISO** field you can view and manage ISO images:

- Click the **Refresh** button to refresh the list of ISO images.

**Note.** ISO images should be placed to the designated library location for ISO files as described in the “Options” – “Templates & Sysprep” section above.

- To remove an ISO image, select it in the list, then click the **Delete** button and confirm the operation.
Using file manager

5nine Manager includes a simple 2-pane file manager. To start 5nine File Manager press the button or use the View → File Manager menu command.

To access different partitions in 5nine File Manager use the View → Select Left/Right View menu commands.

Select and then click OK to get the needed location.

5nine File Manager allows accessing the remote file systems via LAN in the case you are working under the user that has appropriate privileges on remote system. To access remote file system, do either of the following:

- Manually type the remote network address into the Select Left/Right View dialog box:
The remote location will be opened in the appropriate 5nine File Manager pane.

- Manually type the remote network address directly into the lower address bar in the way as shown below and then click Enter:

  ![Select Left View](image)

  C:\\\192.168.1.21\c$\n
The remote location will be opened in a separate Explorer window. This option works in OS with the GUI only.
Working with transfer virtual disk. Copying files between VMs or between VM and host

5nine Manager provides the capability to copy files from VM to VM, and from VM to host. This feature works only on the host where 5nine Manager is installed. It is implemented through a special built-in transfer virtual hard drive.

To copy files from host to a VM, follow these steps:

1. Copy necessary files in 5nine File Manager.

2. Mount the transfer disk to a VM where it is necessary in order to copy files. Go to the Hyper-V Manager tab, select the necessary VM and click the Mount transfer disk button:

The corresponding message will appear in the case of successful disk mount.
**Note.** It is only possible to mount the transfer disk to one of the VMs on the local host. When an attempt to mount the transfer disk to the VMs on the remote host is done, the system will warn you of inability to do so.

3. Connect to the VM via guest console and copy files to VM. If it is the first time the virtual disk is used with this VM, make it online using the Disk Management tool from the Computer Management utility in the guest OS.

**Attention!** Transfer disk can only connected to one VM at this time. When the transfer disk is connected to a VM, it cannot be accessed via File Manager. The opposite is also true. Release the transfer disk prior to moving it to another place.

To release the transfer disk when it is in use in the file manager, select another disk on the file manager pane where the transfer disk is opened.

To release the transfer disk when it is mounted to a VM, go to the Hyper-V Manager tab, select the VM and click the **Unmount transfer disk** button:

![Unmount transfer disk](image)
Integration services

To install integration services to the VM, insert the integration services disk through 5nine Guest Console. To insert the integration services disk through 5nine Guest Console, connect to a VM and use the **Action – Insert Integration Services Setup Disc** menu command (Ctrl+I).
Monitor

Monitor allows visual checking performance parameters on hosts and virtual machines in real time. Data are represented in a graphical view. To view the wanted object performance (Hyper-V host or a virtual machine), select it in the SnineManager object tree and then open the Monitor tab.

Host

Monitor displays the following parameters for Hyper-V host:

- CPU, memory, disk and network top contributors.
- Latest alarms. To filter alarms, use the corresponding buttons:
  - to filter by object type:
    - turn host alarms displaying on/off;
    - turn VM alarms displaying on/off.
  - to filter by alarm type:
    - turn alerts (errors) displaying on/off;
    - turn warnings displaying on/off;
    - turn info displaying on/off.
- CPU, Memory utilization and Disk time (in percent), network utilization (in kbps).
Lines on diagrams:

- Blue line forms a graph of current values for each parameter.
- Yellow dash line shows the warning notification threshold.
- Red dash line shows the critical notification threshold.
- Green dash line shows the trend. The trend is calculated as linear approximation of the parameter values graph (blue line).

Historical data are stored for each performance counter on the host level: CPU, memory, disk and network. To retrieve it and view the diagram, open the corresponding tab. Example, CPU:

To load the data for the wanted period, select the pre-defined period in the drop-down list on the left side (Last hour, Last day, Last week and Last month pre-defined periods are available), or specify the period in the From and To fields manually (use the built-in calendar for convenience). Then press the Load button on the right.
Virtual machine

Monitor displays the following parameters for virtual machines:

- Latest alarms.
- CPU, memory, disk and network utilization.

Lines on diagrams are shown same as for host and have the same meaning.
Historical data is stored for each performance counter on the VM level: CPU, memory, disk and network. To retrieve it and view the diagram, open the corresponding tab. Example, CPU:
Capacity planning

Capacity planning is a plugin integrated into 5nine Manager, which designed to monitor possible performance problems in the Hyper-V environment in the future and warn system administrators.

The approach

Another 5nine Manager feature – Monitor is collecting the following statistic data for Hyper-V hosts’ and virtual machines’ performance counters (please refer to the ‘Monitor’ section above):

- CPU;
- Memory;
- Disk;
- Network.

Capacity planning allows using this information to forecast values of the indicators with regular intervals. Linear regression approach is used.

Depending on crossing point of the approximate line with one of threshold lines the corresponding user notifications will be generated and monitored objects states will be changed.
Dashboard

Dashboard displays the same data for all levels, and contains the following information:

- Upper blocks display parameters that exceeded host/VM capacity thresholds with the trend for each parameter.
- Lower blocks display host/VM resource utilization and threshold exceedance prediction. Only those objects/parameters are displayed that have possible capacity problems in close perspective. Predicted timeframe displays estimated time until the moment when a threshold is expected to be exceeded.
System status report

System Status Report can be generated only on the host level.

When you open the System Status Report tab, you will be asked to choose the data to display:
System Status Report contains the following information:

1. **Host information:**
   - Server configuration (server uptime, number of CPUs, RAM total/available);
   - Disk info;
   - Virtual switch info.

2. **Summary status information:** shows status distribution among VMs in a table and diagram. Shows all possible statuses:
   - Running;
   - Stopped;
   - Saved;
   - Critical;
   - Paused.

3. **Virtual CPU information for each VM:**
   - number of logical processors;
   - VM limit (percentage);
   - VM reserve (percentage);
   - relative weight.

4. **Virtual memory information for each VM:**
   - VM name;
   - dynamic memory usage status (on/off);
   - minimum RAM (for dynamic memory);
   - maximum RAM (for dynamic memory);
   - memory buffer (for dynamic memory);
   - static memory size (dynamic memory off);
   - memory weight.

5. **Virtual disk information for each VM:**
   - VM name on which virtual disk is seated;
   - Disk number;
   - Disk display name;
   - Path to VHD(X) file;
   - Disk size in GB.

6. **Virtual network settings for each VM:**
   - VM name;
   - Virtual adapter number;
   - Virtual network name;
   - Virtual network type: external, internal or private;
   - Dynamic MAC address assignment mode (true/false);
   - VM IP address IP v4/IP v6;
   - Current VM MAC address.

7. **Current state info for each VM:**
   - VM name;
   - VM generation;
   - VM state;
8. **Automatic startup/shutdown**
   - VM name;
   - Automatic start action;
   - Automatic stop action.

9. **Checkpoints info for each VM:**
   - VM name;
   - Checkpoint name;
   - Checkpoint creation date and time;
   - Path to the checkpoint file.

10. **Virtual DVD drives info for each VM:**
    - VM name;
    - Controller type and number, drive number;
    - Mounted media info.

11. **Integration services info for each VM:**
    - VM name;
    - Integration services version;
    - Operating system shutdown availability (yes/no);
    - Time synchronization availability (yes/no);
    - Data exchange availability (yes/no);
    - Heartbeat service availability (yes/no);
    - Backup service availability (yes/no);
    - Guest services availability (yes/no).
Cluster operations

Create cluster

5nine Manager allows joining Hyper-V servers into a cluster. The operation is available from the context menu of the DataCenter object. To open the Create Cluster wizard right click on the datacenter and select the Create Cluster command:

On the Servers screen click the Browse button to select cluster nodes. Then click the Add button to include the chosen server to the cluster. Do this operation for each node separately.

**Note.** Failover clustering feature must be installed on each node that will be joined into a cluster.

Click Next.
Validation helps to determine if your environment and selected nodes are ready to join a cluster. It is recommended to run the tests.

- If you are committed to run the tests, leave the option “Yes” that is set by default.
- If you do not want to run the test, select the second option “No”.

Click Next. If running of validation tests was selected, the Validate Cluster Configuration dialog window will appear:
Select the tests to run and click the **Run Tests** button. Wait until the tests are complete and check the result:

![Validate cluster configuration](image)

Click on the link to open the cluster validation report, or click the **Open** button:

![Microsoft Failover Cluster Validation Report](image)

The Validate a Configuration Wizard must be run after any change is made to the configuration of the cluster or hardware. For more information, see [https://go.microsoft.com/fwlink/?LinkID=280145](https://go.microsoft.com/fwlink/?LinkID=280145).

**Results by Category**

<table>
<thead>
<tr>
<th>Name</th>
<th>Result Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory</td>
<td></td>
<td>Success</td>
</tr>
<tr>
<td>Network</td>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td>System Configuration</td>
<td></td>
<td>Warning</td>
</tr>
</tbody>
</table>
On the **Access Point** screen specify the cluster name and click Next:

Review the summary and click Finish to complete the operation:
Validate cluster

Cluster validation is also available for existing cluster that is managed by 5nine Manager. To validate the cluster, select it in the object tree, right click on it and select the Validate Cluster command. The Validate cluster configuration dialog window will appear:

Select the tests to run and click the Run Tests button. Wait until the tests are complete and check the result:
Click on the link to open the cluster validation report, or click the **Open** button:

### Failover Cluster Validation Report

<table>
<thead>
<tr>
<th>Node</th>
<th>Result Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE1.dev.local</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NODE2.dev.local</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Started</td>
<td>10/22/2015 3:05:12 PM</td>
<td></td>
</tr>
<tr>
<td>Completed</td>
<td>10/22/2015 3:07:18 PM</td>
<td></td>
</tr>
</tbody>
</table>

The Validate a Configuration Wizard must be run after any change is made to the configuration of the cluster or hardware. For more information, see [http://go.microsoft.com/fwlink/?LinkID=280415](http://go.microsoft.com/fwlink/?LinkID=280415).

### Results by Category

<table>
<thead>
<tr>
<th>Name</th>
<th>Result Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Configuration</td>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td>Hyper-V Configuration</td>
<td></td>
<td>Failed</td>
</tr>
<tr>
<td>Inventory</td>
<td></td>
<td>Success</td>
</tr>
<tr>
<td>Network</td>
<td></td>
<td>Success</td>
</tr>
<tr>
<td>Storage</td>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td>System Configuration</td>
<td></td>
<td>Success</td>
</tr>
</tbody>
</table>

**Cluster maintenance mode**

In the case you need to start maintenance operations with some of cluster nodes, 5nine Manager allows setting the nodes on pause with or without draining cluster roles.

To pause cluster node, select it under the ‘cluster’ object and use context menu commands:

- **Pause – Drain Roles** – the node will be paused with automatic live migration of the roles to the best possible node within the cluster;
- **Pause – Do Not Drain Roles** – the node will be paused without automatic live migration of the roles.

To resume cluster node, select it under the ‘cluster’ object and use context menu commands:

- **Resume – Fail Roles Back** – the node will be resumed with automatic live migration of the roles back;
- **Resume – Do Not Fail Roles Back** – the node will be resumed without automatic backward live migration of the roles.

**Attention!** Make sure that there are enough of physical system resources, most importantly RAM on the target host when draining roles. Draining will fail if there are not enough resources to receive additional virtual machines.
Antivirus

The Antivirus feature is available in 5nine Manager with Antivirus. You will be prompted to upgrade 5nine Manager to version with Antivirus when you open the Antivirus tab:

The link will lead you to 5nine site, where you will be able to register and download the trial version of 5nine Manager with Antivirus.
Integration with other products

Special edition of 5nine Manager is integrated with two other products Starwind® Virtual San\(^2\) and Veeam® Backup & Replication™. Starwind® Virtual San (Management Console for Windows) and Veeam® Backup & Replication™ management console can be launched from 5nine Manager. The applications should be installed on the local server, otherwise you will be prompted to visit StarWind Software Inc. or Veeam production site to download and install these products.

button on the top panel launches Starwind® Management Console for Windows application.

button on the top panel launches Veeam Backup & Replication™ management console.

**Attention!** These features are not available in the ordinary version of 5nine Manager.

Setting up the connection with Starwind® Virtual San and Veeam® Backup & Replication™ is simple: there are two additional tabs in Options (please refer to the ‘Options’ section above):

**Veeam**

- Select Veeam® server from the drop-down list. It will be detected automatically when some of managed hosts are running Veeam® Backup & Replication™.

---


After this, corresponding info will appear in the **Veeam** tab of 5nine Manager:

You may filter alarms and jobs:

- ![Alert](image1) – turn alerts (errors) displaying on/off;
- ![Warning](image2) – turn warnings displaying on/off;
- ![Info](image3) – turn info displaying on/off.
- Select Starwind server from the drop-down list. It will be detected automatically when some of managed hosts are running Starwind® Virtual San.

- Select port to connect to Starwind® Virtual San. The default port is 3261 as set in the application.

- Enter credentials to connect to Starwind® Virtual San. The default login is “root” as set in application.
After this, corresponding info will appear in the **Starwind** tab of 5nine Manager:

You may filter alarms:

- ![red_checkmark](red_checkmark.png) – turn alerts (errors) displaying on/off;
- ![yellow_info](yellow_info.png) – turn warnings displaying on/off;
- ![green_on](green_on.png) – turn info displaying on/off.
Licensing

Some features of 5nine Manager are available only in its full version, which requires purchasing and installation of the license. These features now include:

- File Manager;
- Transfer Disk;
- Low Disk space notification;
- VM status icons;
- VM Management operations logging;
- Show virtual disk;
- Enable remote management;
- Operations with host;
- Cluster support;
- Shared Nothing Live Migration;
- Storage Migration;
- Optimizer;
- Monitor;
- Capacity planning;
- System status report;
- Import VM;
- VM Clone/Export;
- Virtual SAN Manager;
- Apply settings to other hosts;
- Best Practices Analyzer;
- Hyper-V logs;
- Library;
- Set VM’s IP address;
- E-mail notifications.
- Replication.

When an attempt to access these features is done on the free version of 5nine Manager, the product prompts you to acquire and install the license.

**Attention!** When a license expires or is removed, product will be drop to the Free version. Only one Hyper-V host is allowed in Free version. 5nine Manager will then stop working without ability to start it again in about an hour. Please take necessary actions to renew your license in advance. Contact techsupport@5nine.com in the case of any questions.

When the license expiration date is getting close (30 and fewer days left to expiration) – 5nine Manager will start warning you each time you open it.
License installation

You can acquire and install the license at any time using the Help – About 5nine Manager main menu command:

Click the “Install license” link to open the license installation dialog:

If you already have the license .txt file, open it, copy its contents and paste it into the dialog as shown on the picture above. If you do not have one, go to www.5nine.com to register and purchase the license. The Buy license link at the bottom of the dialog will also lead you to 5nine production site. Click OK. The corresponding message will appear once the license is successfully activated.
License removal

You can remove the license, e.g. the old one or the one you just no longer need on this instance of 5nine Manager. To remove the currently installed license, select it in the About 5nine Manager dialog box and click the “Remove license” link on the right:

Then confirm the operation.
Product updates

When the newer version of 5nine Manager is available on the 5nine production site, you will be prompted to download it each time you start your currently installed version:

![5nine Manager for Hyper-V](image)

The link shown on the picture above will lead you directly to downloading the newest version. Close all your 5nine Manager windows and then simply proceed with the setup of the fresh version over the existing one in the similar way as described in the ‘Installation’ section.
Product support

Contacting 5nine Software

We always welcome your feedback on the product and your user experience. Please send comments and suggestions to info@5nine.com.

Customer Support

If you have encountered any issue using 5nine Manager, please contact techsupport@5nine.com or ask a question in our Help Forum. Please supply product log files with your query to the support team.
## 5nine Manager log files

5nine Manager writes the following log files that are used to troubleshoot the product and contains information of its activity:

<table>
<thead>
<tr>
<th>Log file name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5nine.Manager.txt</td>
<td>C:\ProgramData\5nine\5nine Manager for Hyper-V\Logs</td>
<td>Contains information of 5nine Manager general functions: objects operations, connection.</td>
</tr>
<tr>
<td>5nine.FileManager.txt</td>
<td>C:\ProgramData\5nine\5nine Manager for Hyper-V\Logs</td>
<td>Contains information related to 5nine File Manager operation.</td>
</tr>
<tr>
<td>5nine.VmConsole.txt</td>
<td>C:\ProgramData\5nine\5nine Manager for Hyper-V\Logs</td>
<td>Contains information related to usage of 5nine Guest Console.</td>
</tr>
<tr>
<td>5nine.Setup.txt</td>
<td>C:\ProgramData\5nine\5nine Manager for Hyper-V\Logs</td>
<td>Contains information about 5nine Manager setup process</td>
</tr>
<tr>
<td>SysPrepHelper.txt</td>
<td>C:\ProgramData\5nine\5nine Manager SysPrepHelper\Logs</td>
<td>Contains information related to templates/sysprep function.</td>
</tr>
</tbody>
</table>
Uninstall

To uninstall 5nine Manager from your server, go to Control Panel – Programs – Programs and Features – Uninstall a Program. Then choose “5nine Manager” on the program list and click Uninstall to run the 5nine Manager uninstallation process, and then follow the system prompts.
Resources

Learn more by visiting:

- Website
  http://www.5nine.com/

- Recorded webinars
  http://www.5nine.com/5nine_webinars.aspx#recorded

- 5nine Manager Page
  http://www.5nine.com/manager

- Product Overview of 5nine Manager
  http://www.5nine.com/Docs/5nineManager_Datasheet.pdf

- Comparison Table of different 5nine Manager Editions
  http://www.5nine.com/Docs/5nine_manager_v7_editions_comparison_en.pdf

- Getting Started Guide of 5nine Manager with Kaspersky Antivirus
  http://www.5nine.com/Docs/5nineManagerPLUSKAV_Guide.pdf

- Getting Started Guide of 5nine Manager with ThreatTrack Antivirus
  http://www.5nine.com/Docs/5nineManagerPLUSVipre_Guide.pdf